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[bookmark: _Toc134265112][bookmark: _Toc529923459][bookmark: _Toc393983609]Reports Main Screen
The Reports menu contains reports developed by the FS Veg staff.
[bookmark: _Toc393983674]Figure 1: Reports main screen
[image: ]
Set the filter options for the Search button
[bookmark: _Ref410302455][bookmark: _Toc393724205]Table 1: File menu bar functionality
	Option
	Description

	Close
	Close the form and return to the previous form

	Save
	Save all changes made to the current form

	Print
	Print a copy of the current form

	Preferences
	Access the user preferences form (see below)

	Exit
	Exit the current form and return to the previous form




[bookmark: _Toc393724206]Table 2: Edit menu bar functionality
	Option
	Description

	Copy
	Copy the highlighted values and place them on the clipboard

	Clear All
	Clear all entries in the current form

	Edit
	Access a pop-up screen; editing can be done in the pop-up screen or directly in the form field

	Insert
	Insert the current record into the database

	Delete
	Delete the current record from the database, including all data associated with record and all child records related to this record; FSVeg_Wizard role is required to delete setting or plot records

	Clear Record
	Clear all entries in the current form; data is saved but not displayed

	Duplicate Record
	Duplicate the current record to the next record; this option only works on a blank record—it duplicates the previous record, but will create a new CN number if needed


[bookmark: _Toc393724207]Table 3: Query menu bar functionality
	Option
	Description

	Cancel Query
	Cancel the current query


[bookmark: _Toc393724208]Table 4: Record menu bar functionality
	Option
	Description

	First Record
	Move to the first record

	Previous
	Move to the previous record

	Next
	Move to the next record

	Last Record
	Move to the last record




The tool bar at the top of the screen has the functionality outlined in the following Figures.
[bookmark: _Toc393983675]Figure 2: Icon: Exit the current form and return to previous form
[image: ]
[bookmark: _Toc393983676]Figure 3: Icon: Save all changes made to current form
[image: ]
[bookmark: _Toc393983677]Figure 4: Icon: Print a copy of current form
[image: ]
The Access icon allows you to access a pop-up screen.  Editing can be done in the pop-up screen or directly in the form field.
[bookmark: _Ref410298450][bookmark: _Toc393983678]Figure 5: Icon: Access a pop-up screen
[image: ]
[bookmark: _Toc393983679]Figure 6: Icon: Insert the current record into database
[image: ]
The delete icon deletes the current record from the database, including all data associated with the record and all child records related to this record; the FSVeg_Wizard role is required to delete setting or plot records.
[bookmark: _Toc393983680]Figure 7: Icon: Delete the current record from database
[image: ]
[bookmark: _Toc393983681]Figure 8: Icon: Clear all entries in current form, data is saved but not displayed
[image: ]
[bookmark: _Toc393983682]Figure 9: Icon: Enter a query to search for a specific code
[image: ]
[bookmark: _Toc393983683]Figure 10: Icon: Execute query
[image: ]
[bookmark: _Toc393983684]Figure 11: Icon: Cancel query
[image: ]
[bookmark: _Toc393983685]Figure 12: Icon: Move to first record
[image: ]
[bookmark: _Toc393983686]Figure 13: Icon: Move to previous record
[image: ]
[bookmark: _Toc393983687]Figure 14: Icon: Move to next record
[image: ]
[bookmark: _Toc393983688]Figure 15: Icon: Move to last record
[image: ]
[bookmark: _Toc393983689]Figure 16: Icon: Access NRIS FSVeg web page
[image: ]
The list of reports contains four fields, as shown in Table 5.
[bookmark: _Ref410298479][bookmark: _Toc393724209][bookmark: _Ref410298459][bookmark: _Ref410298471]Table 5: Reports fields
	Field
	Description

	ID
	A short report name or identifier; used to sort the report list

	Name
	Report name

	Type
	Type of report; valid types are: Oracle Report, Oracle Form, SQL Script, Program Utility, Arc/Info AML, and Other

	Description
	Detailed description of the report




The buttons at the bottom of the screen are described in Table 6.
[bookmark: _Ref410298847][bookmark: _Toc393724210]Table 6: Bottom buttons
	Button
	Description

	Run Oracle Report
	Launch the Oracle report

	Output to Excel
	Place the report result into an MS Excel spreadsheet

	Information
	Access detailed information about the report

	Report Filter
	Set the preferences to use to select which stand(s) will be used in the report

	Use Preferences
	Use the Report Filter preferences to select the stand(s) to use in the report

	Use List
	Use a List of Stands to select the stand(s) to use in the report




[bookmark: _Toc393983610]Report Filter
The report filter button, on the main Report screen, provides the ability to create reports for all settings that match the designated criteria. Once data has been entered in the upper portion of the screen, select either the “all setting IDs” or the “single/multiple setting IDs” button. The “all setting IDs” button will include all settings matching the preference criteria in the reports. The “single/multiple setting IDs” button will produce a list of all setting IDs matching the preference criteria. Individual setting IDs can then be moved from the complete list on the left hand side to the list on the right hand side by using the arrow buttons. All setting IDs on the right hand list will be included in the reports. Preferences remain in effect until you exit the report section. The preference items such as region, forest, district, and location are always saved; however, the list of selected settings is not saved.
Some reports, especially the stand table and volume reports require several seconds to process each setting. Use the Preferences button to limit the number of settings to 20 or less. If more than 20 settings are selected, a warning message will be displayed.
[bookmark: _Toc393983690]Figure 17: Report preferences
[image: ]
To obtain the best performance when using the preference function, the preference information should be entered in order. For example, specifying a Forest number without a Region number will result in slower response time, even if only one Region’s data is stored in the local database. Specifying a District number, without the Region and Forest numbers, results in slower response times. The hierarchy to obtain the best response time is as follows:
Region
Forest
District
Project Name
Measurement Date


[bookmark: _Toc393983611]Report List
The report list provides the ability to create reports for all settings specified in a list.
Step 1. Select the Use List to Run Report at the bottom of the Report screen, as shown in Figure 18.
[bookmark: _Ref410301940][bookmark: _Toc393983691]Figure 18: Measurement Standards form
[image: ]
Step 2. If you have already created a list, use the down arrow to highlight the existing list; then hit the OK button.  The list name will appear in the list box on the main report screen and the stands in the list will be used in the report.
[bookmark: _Toc393983692]Figure 19: Highlight the desired existing list
[image: ]


Step 3. If you want to create a new list, select the List Editor button.  This will take you to the FSVeg List editor screen.  Follow the directions on the form.  They are replicated below for your convenience.
a. Clear the form (if a list has already been entered) by selecting the clear record icon, as shown in Figure 20.
[bookmark: _Ref410302074][bookmark: _Toc393983693]Figure 20: Setting identifiers form
[image: ]
b. Enter a list name and list description
[bookmark: _Toc393983694]Figure 21: Fields for List Name and List Description
[image: ]
c. Click the yellow disk icon to save the list name
[bookmark: _Toc393983695]Figure 22: Save list name
[image: ]
d. Click on File/Preferences to open the window shown in Figure 23
[bookmark: _Ref410302165][bookmark: _Toc393983696]Figure 23: Preferences window
[image: ]
e. Adjust the preferences to select the desired settings from FSVeg.
i. To include all settings, select the All Setting IDs button
ii. To include only some settings:
1. Select Single/Multiple Setting IDs
2. Select a setting ID in the left list box
3. Click on the right-arrow (->) button to move the setting ID to the right list box
4. Add any additional desired settings by selecting them and using the right-arrow button
f. When finished selecting setting IDs, you may change the preferences and select other settings, or click the yellow disk icon to save the selection.
g. Click the Close button.
The list name and associated setting IDs are now displayed in the List Editor, as shown in Figure 24.
[bookmark: _Ref410302209][bookmark: _Toc393983697]Figure 24: List Editor
[image: ]
To close the FSVeg List Editor, select the red folder icon located on the upper left-hand corner of the form, as shown in Figure 25.
[bookmark: _Ref410302275][bookmark: _Toc393983698]Figure 25: Red folder icon
[image: ]


[bookmark: _Toc393983612]Run Oracle Report
This option executes the selected report and displays the results, as shown in Figure 26.
[bookmark: _Ref410302313][bookmark: _Toc393983699]Figure 26: Report results
[image: ]
The icons at the top of the form are shown in Figure 27 and Figure 28.
[bookmark: _Ref410302361][bookmark: _Toc393983700]Figure 27: Save a copy of report to a file icon
[image: ]
[bookmark: _Ref410302367][bookmark: _Toc393983701]Figure 28: Print a copy of report icon
[image: ]


[bookmark: _Toc393983613]Report Descriptions
Table 7 provides a listing of all available reports.  Samples of each report follow.
[bookmark: _Ref410302507][bookmark: _Toc393724211]Table 7:  Descriptions of available reports
	Report #
	Report Name
	Report Description

	1
	List of Project Names
	Provides a list of all project names stored in FSVeg, the first and last date project data was collected, and the number of setting ID records associated with each project name.  This Report does NOT use the preference function.

	2
	List of Setting IDs
	Provides a list of setting IDs stored in FSVeg, grouped by project name.  The Report includes basic information about each setting, including measurement date, ownership, and size.  This Report uses the preference function.

	3
	Setting Administrative Data
	Provides a list of setting IDs stored in FSVeg, grouped by project name.  The Report includes administrative data such as Region, Forest, District, location, stand number, and Agency.  This Report uses the preference function.

	4
	Setting Physical Data
	Provides a list of setting IDs stored in FSVeg, grouped by project name.  The Report includes physical data such as slope, elevation, aspect, and stratum.  This Report uses the preference function.

	5
	Setting Reference Data
	Provides a list of setting IDs stored in FSVeg, grouped by project name.  The Report includes reference data such as examiner, radial and height growth intervals, and remarks.  This Report uses the preference function.

	6
	Setting Damage Data
	Provides setting insect, disease, and damage data stored in FSVeg, grouped by project name and setting ID.  This Report uses the preference function.

	7
	Sample Design
	Provides the sample design data for each setting record in FSVeg, grouped by project name.  This Report uses the preference function.

	8
	Plot Data
	Provides plot data for each plot associated with each setting stored in FSVeg, grouped by project name and setting ID.  The Report includes information about slope, aspect, elevation, history, and fuel models.  This Report uses the preference function.

	9
	Tree Data
	Provides individual tree data stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	10
	Tree Damage Data
	Provides individual tree insect, disease, and damage data stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	11
	Tree Remeasurement Data
	Provides individual remeasured tree data stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	12
	Tree Remeasurement Damage Data
	Provide individual, remeasured t4ree insect, disease, and damage data stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	13
	Vegetation Cover Data
	Provides vegetation data for each plot associated with each setting stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	14
	Surface Cover Data
	Provides surface cover data for each plot associated with each setting stored in FS Veg, grouped by project name setting ID, and plot.  This report uses the preference function.

	15
	Down Woody Data
	Provides down woody material data and fuel data for each plot associated with each setting stored in FSVeg, grouped by project name, setting ID, and plot.  This Report uses the preference function.

	16
	Stand Table
	Provides stand information by user supplied diameter groupings.  This information includes trees-per-acre, and basal-area-per-acre, by live trees, dead trees, and all trees.  This Report uses the preference function.

	17
	Volume Report
	Calculates tree volume information for selected settings, and uses appropriate volume equations for the location.  This Report uses the preference function.

	18
	Species Configuration
	Provides the volume equation, height equation, and site index equations (and their parameters) for selected species, by configuration identifier.

	19
	CSE Comprehensive Stand Report
	Compiles setting, sample design, plot, tree, vegetation, and down woody data into one report.  For use with CSE data only.  This report uses the preference function.

	20
	CSE Brown’s Protocol Report
	Compiles and summarizes downed woody data collected with Brown’s protocol.  Not for use with other types of down woody data.  For use with CSE data only.  This report uses the preference function.

	21
	Multi-stand Report
	Provides multi-stand summary information by user supplied diameter groupings.  This information includes tree-per-acre and basal area-per-acre by live, dead, and all trees.

	22
	Multi-stand Volume Report
	Summarizes tree volume information for selected settings using appropriate volume equations for the location.

	23
	Acres by Age Class Report
	Provides the acres in each age class for a group of stands.  The “Year of Origin” value must be populated.  This value is not populated via CSE; it may be populated using an SQL script or via the Data Table forms.

	24
	Vegetation Structural Stage
	Calculates vegetation structural state (VSS) for selected settings in Regions 2, 3, and 4.

	25
	Cover Summary Report
	Calculates setting level vegetation and surface cover characteristics for selected settings.

	26
	Live Tree Stocking Report
	Calculates setting level vegetation and surface cover characteristics for selected settings.

	27
	NEAT-R TPA Report
	Setting compilation of TPA by diameter and species classes, formatted for use in NEAT-R analyses.  This Report only works for Region 10 tree species and can produce Excel output in the “A” format.

	28
	NEAT-R Volume Report
	Setting compilation of volume per acre by diameter and species classes, formatted for use in NEAT-R analyses.  This report only works for Region 10 tree species and can produce Excel output in either the ”A” or “B” formats.

	30
	User Code Report
	Displays user defined codes and values associated with the parent setting, child setting, tree, and/or cover tables.  Specifically, this is the data that is stored in the nrv_data_code_setmeas, nrv_data_code_treemeas, and nrv_data_covmeas tables.

	31
	Stand Exam Data Source
	Identifies the most recent data source for a given set of stand exams.  Possible sources include an original exam or data created through an FSVeg Spatial operation such as a polygon split, merge, or reshape.

	32
	Stand Exam Data Source Detail
	Identifies the data sources for a given set of stand exams.  Possible sources include an original exam or data created through an FSVeg Spatial operation such as a polygon split, merge, or reshape.  Also provides a detailed history of FSVeg Spatial operations for each setting.




[bookmark: _Toc393983702]Figure 29: Report #1 – List of Project Names
[image: ]


Report #2 provides a list of all “Project Names,” the first and last date the project data was collected, and the number of Setting IDs associated with each project.
[bookmark: _Toc393983703]Figure 30: Report #2 – List of Setting IDs
[image: ]
This report provides a list of all Setting IDs grouped by project Name.  The Setting ID is 16 digits composed of:

RR = 2-digit Region number
FF = 2-digit Forest number
DD = 2-digit District number
LL = up to a 16-digit location number (the actual number is left-justified, without trailing zeros)
SS = 4-digit stand number

The measurement number is valid only for re-measured data.
Report #3 contains administrative data associated with each setting ID, grouped by project name.
[bookmark: _Toc393983704]Figure 31: Report #3 – Setting Administrative Data
[image: ]


Report #4 contains physical data associated with each setting ID, grouped by project name.
[bookmark: _Toc393983705]Figure 32: Report #4 – Setting Physical Data
[image: ]


Report #5 contains the reference data associated with each setting ID, grouped by project name.
[bookmark: _Toc393983706]Figure 33: Report #5 – Setting Reference Data
[image: ]


Report #6 contains the Insect and Disease data for each setting ID, grouped by project name.
[bookmark: _Ref410303049][bookmark: _Toc393983707]Figure 34: Report #6 – Setting Insect, Disease and Damage Data
[image: ]


Report #7 contains the Sample Design data for each setting ID, grouped by project name.
[bookmark: _Toc393983708]Figure 35: Report #7 – Sample Design
[image: ]


Report #8 contains the plot data for each setting ID, grouped by project name.
[bookmark: _Toc393983709]Figure 36: Report #8 – Plot Data
[image: ]


Report #9 contains the individual tree data for each setting ID, grouped by project name.
[bookmark: _Toc393983710]Figure 37: Report #9 – Tree Data Report
[image: ]


Report #10 contains the individual tree insect and disease data for each setting ID, grouped by project name.
[bookmark: _Toc393983711]Figure 38: Report #10 – Tree Insect, Disease and Damage Report
[image: ]


Report #11 contains tree re-measurement data.  The data is grouped by project name, setting ID, and tag number.  Re-measurement data for each tree can be compared and measurement errors quickly located.
[bookmark: _Toc393983712]Figure 39: Report #11 – Tree Remeasurement Data Report
[image: ]


Report #12 contains tree re-measurement insect, disease, and damage data.  The data is grouped by project name, setting ID, and tag number.  Re-measurement data for each tree can be compared and measurement errors quickly located.
[bookmark: _Toc393983713]Figure 40: Report #12 – Tree Remeasurement Insect, Disease and Damage Report
[image: ]


Report #13 contains the vegetation composition data on each plot, for each setting ID, grouped by project name.
[bookmark: _Toc393983714]Figure 41: Report #13 – Vegetation Cover Data
[image: ]


Report #14 contains the ground surface cover data on each plot, for each setting ID, grouped by project name.
[bookmark: _Toc393983715]Figure 42: Report #14 – Surface Cover Data
[image: ]


Report #15 contains the down woody data on each plot, for each setting ID, grouped by project name.
[bookmark: _Toc393983716]Figure 43: Report #15 – Down Woody Material
[image: ]
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[bookmark: _Toc393983614]Stand Table Report
This report contains a stand table summary for each selected setting, one setting at a time. Stand characteristics such as TPA, BA/acre, SDI, and QMD are grouped by diameter classes and by four live/dead categories. The report currently does not include trees with null diameters in the first report sections. The species summary on the third page of the report does contain trees with null diameters.
The report produces the following output:
1. A summary for each setting which includes all of the species. Each setting will produce three pages:
a. Main report with the fixed width, custom, and single-group diameter classes
b. Statistics report with the TPA and BA/acre standard deviations and coefficient of variation
c. Species list
2. If specie or specie group reports are requested, each species/group will produce:
a. Main report with the fixed width, custom, and single-group diameter classes
b. Statistics report with the TPA and BA/acre standard deviations and coefficient of variation
First, reports are produced for each setting for all of the species. Then, reports are produced for each setting by individual species or species groups.
The top portion of the Stand Table Report setup screen contains the settings selected in the Preferences screen, or those found in the list.  The Setup screen allows the user to select an existing personal or master template, or build a new personal template.  To access an existing template, select either the personal or master template button, and select one of the template names that appear on the list.  The user who created the template can modify the template.
[bookmark: _Toc393983717]Figure 44: Stand/Volume/Multi-Stand Report Setup window
[image: ]
[bookmark: _Toc393983615]Building a Template
Each template requires a unique name option or description, and diameter range specifications for each of the three report sections.
[bookmark: _Toc393983616]Fixed-Width Diameter Classes
Select a fixed-width diameter class of 1-, 2-, 3- or 4-inch intervals.  Enter the lower limit of the first interval in the box marked “MIN,” and enter the upper limit for the last interval in the box marked “MAX.”  These values set the lower and upper limits for each fixed-width class.
[bookmark: _Toc393983718]Figure 45: Fixed-width diameter classes form
[image: ]
For example, if the 1-inch diameter class is chosen, the MIN set at 0 and the MAX set at 25, the classes would contain:
0 to 0.9 inch
1.0 to 1.9 inches
20, to 2.9 inches
3.0 to 25.9 inches
26+ inches
If the 4-inch diameter class is chosen, the MIN set at .5 and the MAX set at 27, the classes would contain:
0.5 to 1.4 inches
1.5 to 2.4 inches
2.5 to 3.4 inches
3.5 to 27.5 inches
28+ inches
Note: the MIN value will start the setting points of each class.  For example, if the MIN value is set to 0.0, each class will start at X.0 and end at X.9.  If the MIN value is set at 3.5, each class will start with X.5 and end at X.4.
[bookmark: _Toc393983617]Custom Diameter Classes
The MIN and MAX fields contain the upper and lower diameters if an unlimited number of diameter classes.  Set the MAX field in the last diameter class to “999.9.”
[bookmark: _Toc393983719]Figure 46: Custom diameter classes form
[image: ]
The singe group_class includes all trees above the specified MIN diameter.  It is often used as a “total” line where a minimum of either 0 or 1 inch, although it can be used to summarize the characteristics for all trees above any specified diameter.
[bookmark: _Toc393983618]Select Species/Species Group for Report
Selecting this button will bring up another screen.  The top portion of the screen allows you to select individual species from the window on the left and move them to the window on the right.  A stand table will be produced for each species listed in the right-hand window.
[bookmark: _Toc393983720]Figure 47: Select Individual Species form
[image: ]
The bottom portion of the screen allows you to select species groups from the window on the left and move them to the window on the right.  A stand table will be produced for each species group listed in the right-hand window.  You may select BOTH individual species and species groups.
[bookmark: _Toc393983721]Figure 48: Select Species Groups form
[image: ]
To create a species group, or to add a species to an existing group, select the Add/Edit Species Group button.
A personal species group can be created or edited from the form shown in Figure 34.  To create a list, enter the group name and description in the upper box.  Then enter the NRCS species symbol in the lower box.  If you are unsure of the correct symbol, you can use the LOV button to look up a species symbol.
[bookmark: _Toc393983722]Figure 49: Select Species Groups form
[image: ]
Only personal species groups can be created or edited here.  To create or edit master groups, you must have the Wizard role and go through the “Administration” button on the main menu.
[bookmark: _Toc393983619]Running the Report
After selecting a template, editing an existing template, or creating and saving a new template, select the RUN button at the bottom of the screen.
The bottom of the report has a button “Output to Excel,” that will place the report data into a MS Excel spreadsheet that can be saved and edited.
The first page of the report contains the fixed width, custom and single group diameter class tables.  The stand characteristics are grouped by the diameter classes specified on the setup screen.
[bookmark: _Toc393983723]Figure 50: Page one of the Stand Table Report, Report #16
[image: ]
The second page contains the standard deviations and coefficients of variation for TPA and BA/acre of live trees in the custom and single group diameter classes and Confidence Interval and Sampling Error information.  It also contains the number of plots installed by sample design.
[bookmark: _Toc393983724]Figure 51: Page two of Report #16, part 1: standard deviation and coefficient of variant
[image: ]
[bookmark: _Toc393983725]Figure 52: Page two of Report #16, part 2: sample size
[image: ]
[bookmark: _Toc393983726]Figure 53: Page two of Report #16, part 3: sample design
[image: ]
The third page of this report contains stand characteristics by species.
[bookmark: _Toc393983727]Figure 54: Stand characteristics by species
[image: ]
BA/acre and TPA information for tree class and cut/leave information are also available as part of this report.
[bookmark: _Toc393983728]Figure 55: BA and TPA information
[image: ]
There are a number of terms used in this report, as defined in Table 8.
[bookmark: _Ref410307961][bookmark: _Toc393724212]Table 8: Definitions
	Term
	Description

	Live
	All live trees with a recorded diameter.  The total line includes trees with null diameters.

	Recent Mortality
	All dead trees with a recorded diameter and a log/snag decay class of “1.”  The total line includes trees with null diameters.

	Older Dead
	All dead trees with a recorded diameter and a log/snag decay class greater than “1.”  The total line includes trees with null diameters.

	All
	All trees with a recorded diameter.  The total line includes trees with null diameters.

	Diameter Class
	The upper and lower limits of each diameter class, in inches.  The report does not distinguish between measurements at breast height and measurements at root collar.

	TPA
	Trees per acre of trees with a recorded diameter.

	BA/A
	Basal area per acre of trees with a recorded diameter.

	SDI
	Stand density index, which describes a class’ contribution to the total index for the stand.  The SDI for this report is computed using A1 Stage’s individual tree transformation of Reineke’s SDI equation (Stage, A.L., 1968).  This equation uses all live, on-plot trees with a diameter.  When applied to a group of sampled trees, the result is numerically equivalent to Reineke’s equation for that group, namely:
[image: ]	where Dq is the quadratic mean diameter.
This value does not include trees with null diameters, hence, it will not match with cycle zero of the Forest Vegetation Simulator (FVS) which assigns a “0.1” diameter to all trees with null diameters and uses them in the SDI calculations.  To make the FVS CDI calculation the same as FSVeg, add the following keywords to FVS:
Compute	0
MySDI = SpMcDBH(11,All,0,0.2,999,0,000,0,0)
End

	QMD
	Quadratic mean diameter, in inches, of trees with a recorded diameter.  This is the diameter of the tree with the average basal area.

	AVG HT
	Average height, in feet, of trees with a recorded height.  This value is not weighted by TPA or BA/A.

	AVG CR
	Average crown ratio, in percent, of trees with a recorded crown ratio.  This value is not weighted by TPA or BA/A.

	AVG AGE
	Average age, in years, of trees with a recorded age.  This value is not weighted by TPA or BA/A.

	AVG DGR
	Average diameter growth, in inches per year, of trees with a recorded diameter increment.  This value is not weighted by TPA or BA/A.  Only measurements for the first increment period are included; measurements for a second increment period, if taken, are not included.

	AVG HGR
	Average height growth, in feet, of trees with a recorded height growth.  This value is not weighted by TPA or BA/A.




Note:
1. Only trees with diameters greater than 0 are used in computing QMD and SDI for the previous tables.
2. SDI is computed using Stage’s tree-by-tree version of Reineke’s stand density equation (Stage, A.L., 1968.  A tree-by-tree measure of site utilization for grand fir related to stand density index.  U.S. Forest Service Research Note INT-77).
3. AVG HT, AVG CR, AVG AGE, AVG DGR, and AVG HGR are computed as simple averages of all non-null and nonzero per acre values within the size class.  They are neither weighted by basal area nor otherwise “distributed” among non-measured stems.
4. 
The Sample Size is based on the single group class statistics, and is obtained using:
n = 
Where “n” is the estimated number of plots required to achieve a percent sampling error (E) for a population with a coefficient of variation (CV).  For the purpose of this report, estimates are computed for three different confidence intervals: 68.3% (t = 1), 90% (t = ~1.645), and 95% (t= ~1.960).  The true value of the estimate (TPA, BA/ac) would be expected 68.3%, 90%, or 95% of the time (depending on the selected confidence interval) within plus or minus the desired percent sampling error (E) for the estimated sample size.
5. Trees with null diameters are displayed in the Species Summary table as well as in the “Null Diameter” class at the top of the main tables, above the fixed-width diameter classes.  They are not included in either the custom diameter classes or the single class parts of these tables.


[bookmark: _Toc393983620]Volume Report
This report contains a volume summary for each selected setting, one setting at a time.  Volumes include gross cubic foot volume, gross merchantable cubic foot volume, and gross board foot volume (for Region 9, the values produced under these headings are the gross pulp cubic foot volume, gross sawtimber cubic foot volume, and gross sawtimber board foot volume, respectively).  The results are grouped by diameter classes and four live/dead categories.  The report currently does not include trees with null diameters in the first report sections.  The species summary on the third page of the report does contain trees with null diameters.
When the Volume Report is selected, a Setup screen appears.  The top portion if the screen contains the settings selected in the Preferences screen.  The Setup screen allows the user to select an existing personal or master template, or build a new personal template.  To access an existing template, select either the personal or master template button, and select one of the template names that appear on the list.  Only the template author can modify personal templates.
[bookmark: _Toc393983729]Figure 56: Volume Report setup screen
[image: ]
[bookmark: _Toc393983621]Building a Template
Each new template requires a unique name and the diameter range specifications for each of the three report sections.
[bookmark: _Toc393983622]Fixed Width Diameter Classes
Select a fixed-width diameter class of 1-, 2-, 3-, or 4-inch intervals.  Enter the lower limit of the first interval in the box marked “MIN,” and enter the upper limit for the last interval in the box marked “MAX.”  These values set the lower and upper limits for each fixed-width class.
[bookmark: _Toc393983730]Figure 57: Fixed-width diameter classes
[image: ]
For example, if the 1-inch diameter class is chosen, the MIN set at 0 and the MAX set at 25, the classes would contain:
· 0 to 0.9 inches
· 1.0 to 1.9 inches
· 2.0 to 2.9 inches
· 25.9 inches
· 26+ inches
If the 4-inch diameter class is chosen, the MIN set at .5 and the MAX set at 27, the classes would contain:
· 0.5 to 1.4 inches
· 1.4 to 2.4 inches
· 2.5 to 3.4 inches
· 44 to 27.5 inches
· 28+ inches
Note:  the MIN value will set the starting points of each class.  For example, if the MIN value is set to 0.0, each class will start at X.0 and end at X.9.  If the MIN value is set at 3.5, each class will start at X.5 and end at X.4.
[bookmark: _Toc393983623]Custom Diameter Classes
The MIN and MAX fields contain the upper and lower diameters if an unlimited number of diameter classes.  Set the MAX field in the last diameter class to “999.9.”
The single_group_class, as shown in the bottom of Figure 58, includes all trees above the specified MIN diameter.  It is often used as a “total” line where a minimum of either 0 or 1 inch, although it can be used to summarize the characteristics for all trees above any specified diameter.
[bookmark: _Ref410308076][bookmark: _Toc393983731]Figure 58: Custom diameter classes
[image: ]
[bookmark: _Toc393983624]Select Species for Report
[bookmark: _Toc393983732]Figure 59: Report options
[image: ]
A volume table will be produced for each individual species selected, as shown in Figure 60.
[bookmark: _Ref410308128][bookmark: _Toc393983733]Figure 60: Select Individual Species screen
[image: ]
[bookmark: _Toc393983625]Running the Report
After selecting a template, editing an existing template, or creating and saving a new template, select the RUN button at the bottom of the screen.  The bottom of the report screen has a button, “Output to Excel,” that will place the data in the report into a MS-Excel spread sheet which can be saved and edited.
The first page of the report contains the fixed width, custom, and single group diameter class tables.  The volumes are grouped by specified diameter classes (Note: Merch cubic volume is computed to a specified top diameter and stump height.  It does not take defect into account.).
If you are working in Region 9, please see the Special Notes section of this Chapter.
[bookmark: _Toc393983734]Figure 61: Page 1 of Volume Report
[image: ]
The second page contains the standard deviations of the volumes by diameter class and live/dead status.
[bookmark: _Toc393983735]Figure 62: Page 2 of the Volume Report
[image: ]
This third part of this report contains volumes by species and the number of plots installed sample design.
[bookmark: _Toc393983736]Figure 63: Page 3 of the Volume Report
[image: ]
[bookmark: _Special_Note]The fourth part contains the volume information for all species.
[bookmark: _Toc393983737]Figure 64: Part 4 of the Volume Report – Gross Volume
[image: ]
Volumes for tree class and cut/leave information are also available as part of this report, as shown in Figure 65.
[bookmark: _Ref410308448][bookmark: _Toc393983738]Figure 65: Tree class and cut/leave information in Volume Report
[image: ]
Table 9 provides descriptions for select terms used in the Volume Report.
[bookmark: _Ref410381608][bookmark: _Toc393724213]Table 9: Volume Report definitions
	Term
	Description

	Live
	All live trees with a recorded diameter.  The total line includes trees with null diameters.

	Recent Mortality
	All dead trees with a recorded diameter and a log/snag decay class of “1.”  The total line includes trees with null diameters.

	Older Dead
	All dead trees with a recorded diameter and a log/snag decal class greater than “1.”  The total line includes trees with null diameters.

	All
	All trees with a recorded diameter.  The total line includes trees with null diameters.

	Diameter Class
	The upper and lower limits of each diameter class, in inches.  The report does not distinguish between measurements at breast height and measurements at root collar.

	Cubic Vol
	Gross cubic foot volume (for R9, this is the gross pulp cubic foot volume).

	Merch C Vol
	Gross merchantable cubic foot volume (for R9, this is the gross sawtimber cubic foot volume).

	Board Vol
	Gross board foot volume (for R9, this is the gross sawtimber board foot volume).


It should be noted that only gross volumes are represented in this report.  Additionally, the Sample Size is based on the single class statistics and is obtained using:

n=
Where “n” is the estimated number of plots required to achieve a percent sampling error (E) for a population with a coefficient of variation (CV).  For the purposes of this report, it is assumed that t = 1 (corresponding to a probability of about 68.3%0, so that the equation is reduced to:

n=
The true value of the estimate (TPA, BA/ac) is within plus or minus the percent sampling error 68.3% of the time.
[bookmark: _Toc393983626]Special Notes
There are three separate volumes calculated in FSVeg.  These are cubic, merch cubic, and board foot volume.  Region 9 data is somewhat different from the other regions. This section will help you understand the differences.
For Region 9, cubic volume is the cubic foot volume from both sawtimber and pulpwood trees calculated from stump to a 4-inch diameter top.  In sawtimber trees this includes both the sawlog portion and the topwood.  It never includes any limbs or the top above the 4-inch diameter.
For Region 9, merch cubic volume is the cubic foot volume in the sawlog portion of sawtimber trees.  It does not include the topwood volume.  It also does not include pulpwood tree volume.
For Region 9 data, board foot volume is either the Scribner or International 1/4 board foot volume, depending on the forest.  The Chippewa, Superior, Chequamegon-Nicolet, Ottawa, and Hiawatha get Scribner.  All other forests get International 1/4.
Since FSVeg does not store information on whether a tree is pulpwood or sawtimber, the program must make this determination for each tree based on DBH in Region 9.  Each forest has a set of minimum DBH values that the different species must meet in order to be considered pulpwood or sawtimber.  Minimum pulpwood DBH is 4, 5, 6, or 8 inches depending on forest and species.  Minimum sawtimber DBH is typically 7, 9, or 11 inches depending on forest and species.  There is one particular species on one forest where the minimum is 8 inches.


[bookmark: _Toc393983627]Species Configuration Report
This report contains the gross board foot volume equation, gross cubic foot volume equation, gross merchantable cubic foot volume equation, height equation, and Site Index for selected species by a configuration identifier. In addition, parameters of each equation are displayed.
[bookmark: _Toc393983739]Figure 66: Species Configuration window
[image: ]
Step 1. Select a configuration identifier.  This may be a regionally-defined configuration set, or a user-defined set.
Step 2. Move individual or all species from the left-hand to the right-hand list.
Step 3. Select OK to run the report or Cancel to return to the main report menu.
[bookmark: _Toc393983740]Figure 67: Sample Species Configuration Report
[image: ]


[bookmark: _Toc393983628]CSE Comprehensive Stand Report
This report contains information about the setting, sample design, plots, tree data, surface cover data, vegetation data, and down woody data. In addition, if the down woody data was collected using Brown’s protocol, this report will contain an analysis of the volume and tons per acre of down woody material.
[bookmark: _Toc393983741]Figure 68: CSE comprehensive stand report
[image: ]
[bookmark: _Toc393983742]Figure 69: Species of Management Interest report
[image: ]
[bookmark: _Toc393983743]Figure 70: Sample design
[image: ]
[bookmark: _Toc393983744]Figure 71: Plot data
[image: ]
[bookmark: _Toc393983745]Figure 72: Tree Data
[image: ]
[bookmark: _Toc393983746]Figure 73: Legend for Tree Damage Codes
[image: ]
[bookmark: _Toc393983747]Figure 74: Calculated Values
[image: ]
[bookmark: _Toc393983748]Figure 75: Vegetation composition and surface cover measurements
[image: ]
[bookmark: _Toc393983749]Figure 76: Legend for layer codes and life form codes
[image: ]
[bookmark: _Toc393983750]Figure 77: Surface cover
[image: ]
[bookmark: _Toc393983751]Figure 78: Downed woody data
[image: ]
[bookmark: _Toc393983752]Figure 79: Additional downed woody data
[image: ]
[bookmark: _Toc393983753]Figure 80: Downed woody pieces per acre
[image: ]
Note: The forest typing algorithm is a hierarchical procedure. The algorithm begins by comparing the live tree stocking of softwoods and hardwoods and continues in a stepwise fashion comparing successively smaller subgroups of the preceding aggregation of initial types. The aggregated initial type groups used at each step of the process are called combined type groups. Each initial type group can occur in more than one of these combined groups. The stepwise progression proceeds in most cases until a plurality of an initial type group is identified. In certain situations, the algorithm may revert to the field call. Nonstocked forest land has a live tree stocking < 10.
[bookmark: _Toc393983754]Figure 81: User codes
[image: ]


[bookmark: _Toc393983629]CSE Brown’s Protocol Report
This report contains data collected on the Down Woody Form according to Brown’s protocols.  It contains an analysis of the volume and tons per acre using the formulas found in Brown’s publication.
[bookmark: _Toc393983755]Figure 82: CSE Brown's Protocol report
[image: ]
[bookmark: _Toc393983756]Figure 83: downed woody pieces per acre
[image: ]
[bookmark: _Toc393983757]Figure 84: Transect measurements
[image: ]


[bookmark: _Toc393983630]Multi-Stand Report
This report works exactly like the Stand Table report except it averages data for multiple stands. These stands are selected via the Preferences or List options.  The pull-down box at the bottom of the screen provides the ability to weight each stand by acres (area), number of plots (plot), or equal weights (non-weighted).
[bookmark: _Toc393983758]Figure 85: Stand/volume/multi-stand report setup
[image: ]
The bottom of this report has an “Output to Excel” button that will place the data in the report into a MS-Excel spreadsheet.  The spreadsheet can then be saved and edited.
The weight methods are outlined in Table 10.
[bookmark: _Ref410309093][bookmark: _Toc393724214]Table 10: Weight methods
	Method
	Description

	Non-weighted
	The volume or stand data from each stand has equal weight:  (Stand A data + Stand B data)/2

	Area weighted
	The volume or stand data from each stand is weighted by the number of acres in each stand.  For example, if Stand A has 100 acres and Stand B has 50 acres, then: ((100 x Stand A data) + (50 x Stand B data))/150

	Plot weighted
	The volume or stand data from each stand is weighted by the number of plots in each stand.  For example, if Stand A has 15 plots and Stand B has 7 plots, then: ((15 x Stand A data) + (7 x Stand B data))/22


[bookmark: _Toc393983759]Figure 86: Multi-stand summary, page 1
[image: ]
[bookmark: _Toc393983760]Figure 87: Multi-stand summary, page 3
[image: ]
One of the report sections contains a description of each sample design associated with each stand included in the report.
BA/acre and TPA information for tree class and cut/leave information are also part of this report, as shown in Figure 88.
[bookmark: _Ref410309173][bookmark: _Toc393983761]Figure 88: TPA and BA information
[image: ]


[bookmark: _Toc393983631]Multi-Stand Volume Report
This report works exactly like the Volume report except it averages the data for multiple stands.  These stands are selected via the Preferences or List options.  The pull-down box at the bottom of the screen provides the ability to weigh each stand by acres (area), number of plots (plot), or equal weights (non-weighted).
If you are working in Region 9, please read the Special Notes section of this Chapter.
[bookmark: _Toc393983762]Figure 89: Stand/volume/multi-stand report setup
[image: ]
The bottom of the report has a button, “Output to Excel,” that will place the data in the report into a MS-Excel spread sheet. The spread sheet can then be saved and edited.
[bookmark: _Toc393983763]Figure 90: Multi-stand summary, page 1
[image: ]


At the top of the report, the weight method is displayed.
[bookmark: _Toc393983764]Figure 91: Multi-stand summary, page 3
[image: ]
One of the report sections contains a description of each sample design.
Volumes for tree class and cut/leave information are also available as part of this report:
[bookmark: _Toc393983765]Figure 92: Volumes by species and tree class
[image: ]
[bookmark: _Special_Notes:][bookmark: _Toc393983632]Special Notes:
There are three separate volumes calculated in FSVeg.  These are cubic, merch cubic, and board foot volume. Region 9 data is somewhat different from the other regions. This section will help you understand the differences.
For Region 9, cubic volume is the cubic foot volume from both sawtimber and pulpwood trees calculated from stump to a 4-inch diameter top.  In sawtimber trees this includes both the sawlog portion and the topwood.  It never includes any limbs or the top above the 4-inch diameter.
For Region 9, merch cubic volume is the cubic foot volume in the sawlog portion of sawtimber trees.  It does not include the topwood volume.  It also does not include pulpwood tree volume.


For Region 9 data, board foot volume is either the Scribner or International 1/4 board foot volume, depending on the forest. The Chippewa, Superior, Chequamegon-Nicolet, Ottawa, and Hiawatha get Scribner.  All other forests get International 1/4.
Since FSVeg does not store information on whether a tree is pulpwood or sawtimber, the program must make this determination for each tree based on DBHin Region 9.  Each forest has a set of minimum DBH values that the different species must meet in order to be considered pulpwood or sawtimber.  Minimum pulpwood DBH is 4, 5, 6, or 8 inches depending on forest and species.  Minimum sawtimber DBH is typically 7, 9, or 11 inches depending on forest and species.  There is one particular species on one forest where the minimum is 8 inches.


[bookmark: _Toc393983633]Acres by Age Class Report
This report contains the acres in each age class for two or more settings. The “Year of Origin” value must be populated for each setting. This value is NOT populated via the CSE forms; it may be populated via the Data Table forms.
[bookmark: _Toc393983766]Figure 93: Acres by age class report
[image: ]


[bookmark: _Toc393983634]Vegetation Structural Stage Report
This report calculates the vegetation structural stage (VSS) for Regions 2, 3, and 4.
[bookmark: _Toc393983767]Figure 94: Vegetative structural stage report
[image: ]
[bookmark: _Toc393983768]Figure 95: Class sizes
[image: ]
[bookmark: _Toc393983769]Figure 96: Stand density index rating
[image: ]
The VSS Report was built on the basis of processes developed by Regions 2, 3, and 4 to address VSS issues.  These routines used Shaw's summation method of computing VSS, using all live, on-plot trees with a diameter ≥ 1:
[image: ]
In this equation, Dj is the diameter of an individual tree record and tpaj is the TPA that record represents at the stand level.
This equation is used because the Regions that built the original routines believe a summation approach yields better results when dealing with uneven-aged stands.


[bookmark: _Toc393983635]Cover Summary Report
This report calculates setting level vegetation composition and surface cover characteristics.
[bookmark: _Toc393983770]Figure 97: cover by lifeform
[image: ]
[bookmark: _Toc393983771]Figure 98: Cover by surface cover
[image: ]


[bookmark: _Toc393983636]Live Tree Stocking Report
Setting level report of live trees-per-acre and basal area-per-acre by species and standard diameter classes.  The report includes quadratic mean diameter by species.  This report has the ability to place the output in an MS Excel spreadsheet.
[bookmark: _Toc393983772]Figure 99: Live tree stocking report
[image: ]
If you run this report using Region 9 data, the Size Density parameter is also included.  All other regions will report the GIS Link.
[bookmark: _Toc393983773]Figure 100: Live tree stocking report
[image: ]
[bookmark: _Toc393983774]Figure 101: Live tree stocking report
[image: ]


[bookmark: _Toc393983637]NEPA-R TPA
This report is a setting level compilation of TPA by diameter and species classes, formatted for use with Region 10’s NEAT-R program.  The report can produce MS-Excel output in the “A” format.  The setup for the report uses the Stand and Volume Multi-Stand Report Setup Screen.
[bookmark: _Toc393983775]Figure 102: NEAT-R report
[image: ]
[bookmark: _Toc393983776]Figure 103: statistics report
[image: ]
[bookmark: _Toc393983777]Figure 104: Sample size
[image: ]


[bookmark: _Toc393983638]NEAT-R Volume
This report is a setting compilation of volume per acre by diameter and species classes, formatted for use with the Region 10 NEAT-R program.  The report can produce Excel output in either the “A” or “B” formats.  The setup for the report uses the Stand and Volume Multi-Stand Report Setup Screen.
[bookmark: _Toc393983778]Figure 105: NEAT-R Volume report, page 1
[image: ]
[bookmark: _Toc393983779]Figure 106: NEAT-R Volume report, page 2
[image: ]

[bookmark: _Toc393983639]User Code Report
This report displays user defined codes and values associated with the setting, tree, plot, and/or cover tables.  Specifically, this is the data that is stored in the nrv_data_code_setmeas, nrv_data_code_treemeas and nrv_data_covmeas tables.
[bookmark: _Toc393983780]Figure 107: Run user codes report
[image: ]
Select which codes and values are to be displayed in the report.
[bookmark: _Toc393983781]Figure 108: Setting, plot, tree, and cover user codes
[image: ]


[bookmark: _Toc393983640]Stand Exam Data Source Report
This report is designed to support spatial data operations by identifying the origins of a selected group of stand exams.  In the course of spatial editing, stand boundaries can undergo significant manipulation, and it is important that the tabular data associated with the affected area be dealt with appropriately so that it accurately reflects the new situation on the ground.  The FSVeg Spatial software, coupled with key decisions made by the Spatial Editor, will ensure that tabular data in FSVeg will keep in step with the splits, merges, links, archiving, and so on that can occur.
Once the dust of a spatial editing session clears, it is occasionally helpful to be able to identify the provenance of the resultant stands in the tabular database.  Sometimes, one is interested in just the stands that were created as a result of a particular spatial edit operation, such as splits or merges.  In other cases, one might be interested in seeing everything including stands that were not edited as well as the stands that got archived, and everything in between.  Or you may be a Spatial Steward who wishes to keep tabs on the recent changes made by a Spatial Editor under your supervision.  Report 31 will address these and other questions regarding the origin, or derivation, of the tabular data for a set of stand exams which have been subjected to spatial edit operations.  It should be noted that this report provides only a broad overview and does not delve deeply into the details of all the spatial operations that may have occurred to a particular stand—the task of displaying such details is handled by Report 32, Stand Exam Data Source Detail.
The Stand Exam Data Source Report Options form is shown below.  On this form you can specify what archive status, spatial edit history, spatial editor, or spatial edit date range to retrieve for the report.  Click OK when you are ready to produce the report.
Figure 109 shows the Stand Exam Data Source Report Options screen where you can narrow your search by selecting specific spatial editing functions performed by FSVeg Spatial.
[bookmark: _Toc393983782]Figure 109: Narrow search using Spatia Edit History
[image: ]
The report contains information dependent upon the preferences you set in the previous forms.  The example in Figure 110 identifies a stand that had its origins in an FSVeg Spatial merge.
[bookmark: _Ref410310354][bookmark: _Toc393983783]Figure 110: Stand exam data source report
[image: ]


[bookmark: _Toc393983641]Stand Exam Data Source
Report 32 is very similar in concept to Report 31, but takes the output a step further in that it will produce the unvarnished, blow-by-blow details of the sequence of spatial edit operations that occurred to bring a particular stand into existence (or, in some cases, that led to it’s getting archived).  Warning: Because the minutiae of the spatial edit histories will be displayed, the output can necessarily become rather lengthy and complex.  Operations for a given stand are listed in chronological order, with sets of boxes outlining groups of related operations.
Bounded by the choices made in the Preferences form, this report will produce detailed information on FSVeg Spatial edit operations for the selected stands.
[bookmark: _Toc393983784]Figure 111: Stand exam data source detail report
[image: ]


[bookmark: _Toc393983642]Summary Data
A summary:
· Is easy to use
· Is flexible; the data are summarized any way the user specifies
· Is permanent; the data are stored in permanent Oracle tables
· Contains one line of data for each setting included in the summary
· Is portable; data can be accessed via MS Access or MS Excel
· Is versatile; multiple summaries can be created to summarize the data in different ways
· Is current; summaries can be refreshed anytime to include recently inventoried stands
Table 11 provides a list of all steps involved and a description of each step, which are outlined in more detail following the table.
[bookmark: _Ref410310630][bookmark: _Toc393724215]Table 11: Summary data steps
	Step
	Description

	1
	Obtain the NRV_Summary Oracle role

	2
	Access the Summary forms

	3
	Create the Summary header record

	4
	Define the settings to include the Summary

	4A
	· Spatial Option

	4B
	· Non-Spatial Option

	5
	Define the data priorities to use in the Summary

	6
	Select/Create one or more Groups to use in the Summary

	6A
	· Select an Existing Group

	6B
	· Create a New Group

	7
	Create one or more Subgroups for each group

	8
	Execute the Summary

	9
	View the Summary Results

	9A
	· Characteristics

	9B
	· Summary Report

	9C
	· Groups


[bookmark: _Toc393983643]Step 1: Obtain the NRV_Summary Oracle Role
Anyone may look at and use summary data, but the “NRV_Summary” Oracle role is required to create a Summary.  To request this role, you must go through the User Management Application (UMA) process.  Additional information is available on the User Management Application Help webpage.
[bookmark: _Toc393983644]Step 2: Access the Summary Forms
These forms are accessed from the main FSVeg screen, shown in Figure 112.
[bookmark: _Ref410310664][bookmark: _Toc393983785]Figure 112: FSVeg welcome screen
[image: ]
[bookmark: _Step_3:_Create_1][bookmark: _Toc393983645]

Step 3: Create the Summary Header Record
The first screen is called the “Summary Strategies” screen and is used to: select an existing summary, create a new summary, run an existing summary, or re-run an existing summary.
[bookmark: _Toc393983786]Figure 113: Summary strategies screen
[image: ]
[bookmark: _Toc393724216]Table 12: Summary header steps
	Step
	Field
	Command

	3.1
	Show
	Show all the summaries created across the nation, only those summaries created in your Region, or only those summaries created in your Forest.

	3.2
	Summary*
	Required.  Enter a unique identifier, less than or equal to 10 characters.  The identifier may include letters, numbers, and special characters (except “%,” a comma, or double quotes).  A dash, underscore, or space is allowed.

	3.3
	Summary Name*
	Required.  Enter a descriptive name, less than or equal to 30 characters.

	3.4
	Summarize?
	This field defaults to “No” for new summaries.  Once the summary is completely defined, this field can be set to “Yes” to create the summary:
· Yes: Run this summary when the “Run Summary” button is selected.  When this form is exited, the user is prompted to set all “Yes” values to “No.”
· No: Do not run this summary when the “Run Summary” button is selected.
· Running: Indicates a summary is currently running.
· Lock: Only the creator of the Summary Table may update it, change it, or unlock it.

	3.5
	Summary Method
	Set this field to “New Summary.”  Once the summary has been created, it can be re-run with the “Add/Update” option:
· New Summary: Existing summary data is deleted prior to re-running the summary.
· Add/Update: Existing summary data is not deleted unless the data is flagged to be re-summarized.  In addition, newly inventoried stands may be added to the summary.

	3.6
	Start/End Times
	These fields cannot be edited.  If a summary has already been run, this is the time the summary was started and the time the summary completed.  This will provide an indication of how long it took the summary to process.

	3.7
	Setting Count
	This field cannot be edited.  If a summary has already been run, this is the number of settings included in the summary.

	3.8
	Group/
Subgroup Count
	This field cannot be edited.  If a summary has been run, this is the number of groups and subgroups included in the summary.

	3.9
	Data Type
	Set this field to specify stand or cluster data.  Most data is stand data.  Stand and cluster data cannot be mixed in the same summary.
· Stand: Only stand data will be used in the summary.
· Cluster: Only cluster data will be used in the summary.

	3.10
	Purpose Code
	Only data with the specified purpose code will be included in the summary.  Most summaries leave this field Null.

	3.11
	Diameter Type
	Which diameter type should be used to calculate average diameter.  Choices include:
· AVG: Average diameter
· QMD: Using all trees
· QMD1: Using only trees 1-inch and above in diameter; Spatial FSVeg default
· QMD5: Using only trees 5-inches and above in diameter

	3.12
	Summarize Cover
	Should the understory and surface cover subgroups be included in the summary?  This could produce a tremendous amount of data.

	3.13
	Remarks
	Enter remarks about the summary in this field.
The rest of the fields on this screen are filled in after the summary is executed.  These will be discussed in Step 9: View the Summary Results.

	3.14
	Spatial/Non-Spatial
	Select the “Spatial/Non-Spatial” tab at the top of the screen and continue to Step 4.


[bookmark: _Step_4:_Define][bookmark: _Toc393983646]Step 4: Define the Settings to Include in the Summary
[bookmark: _Toc393724217]Table 13: Define setting steps
	Step
	Field
	Command

	4.1
	Spatial/Non-Spatial
	Decide if you want to select the setting IDs by the Spatial or Non-Spatial option, and select the appropriate radio button on the left-hand part of the screen.  The corresponding section of this screen is activated.  Go to Step 4A for the Spatial option, and Step 4B for the non-spatial option.


[bookmark: _Toc393983647]Step 4A: Spatial Option
This option provides the ability to create a summary for all settings in the specified feature class(s).  The polygon IDs are obtained from the feature class and from that, a list of stands to summarize is created.  The GIS_LINK column in NRV_Setting_Measurements contains the polygon ID.  The summary process cross-references the data in this list to the GIS_LINK column in FSVeg to obtain the attribute data to summarize.  If multiple feature classes are listed, all of the polygons across all of the feature classes are summarized.  If two or more feature classes contain the same polygon ID, the data for that polygon will only get summarized once.  To use this option, you must have access to ArcGIS.
[bookmark: _Toc393983787]Figure 114: Spatial settings form
[image: ]
[bookmark: _Toc393724218]Table 14: Spatial setting steps
	Step
	Field
	Command

	4A.1
	Feature Class Name
	Decide if you want to select the setting IDs by the Spatial or Non-Spatial option, and select the appropriate radio button on the left-hand part of the screen.  The corresponding section of this screen is activated.  Go to Step 4A for the Spatial option, and Step 4B for the non-spatial option.

	4A.2
	Path
	Enter the path to where the coverage is stored on the server such as: “/fsfiles/ref/library/my_forest.”  Do not include a slash at the end of the path.  Use the Down Arrow to navigate to the coverage(s) and obtain the coverage name and the path.

	4A.3
	Feature Class Relate Key
	Enter the item name in the coverage that contains the polygon ID or key that links the polygon to the attribute data in FSVeg.  In FSVeg, the polygon ID is stored in “GIS_LINK.”

	4A.4
	Current Flag
	Indicate if this is a current or historic coverage.  This is for documentation purposes only.  Regardless of this flag, all coverages listed on this form are not used to generate the list of stands.

	4A.5
	Max Age
	The maximum age of a stand that will be included in the summary.

	4A.6
	Min/Max Date
	The minimum and/or maximum survey dates to include in the summary.

	4A.7
	Archive?
	Should archived data be included in the summary?

	4A.8
	Remarks
	Enter remarks about the coverage(s) and the stand(s) that will be extracted.


[bookmark: _Toc393983648]

Step 4B: Non-Spatial Option
This option provides the ability to create a summary for all settings that match the designated criteria.
[bookmark: _Toc393983788]Figure 115: Non-spatial settings form
[image: ]
[bookmark: _Toc393724219]Table 15: Non-spatial setting steps
	Step
	Field
	Command

	4B.1
	Admin Region
	Enter the administrative Region of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.2
	Admin Forest
	Enter the administrative Forest of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.3
	District
	Enter the District of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.4
	Measurement No.
	Enter the measurement number of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.5
	Location
	Enter the location of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.6
	Project Name
	Enter the project name of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.7
	Data Type
	Is this “Stand” or “Cluster” data?

	4B.8
	Proc. Region
	Enter the Proclaimed Region of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.9
	Proc. Forest
	Enter the Proclaimed Forest of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.10
	State
	Enter the state of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.11
	County
	Enter the county of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.12
	Agency
	Enter the agency of the settings to include in the summary.  If left blank, this field will not be used to select stands to include in the summary.

	4B.13
	All Setting IDs
	Select this radio button if you want all settings that match the criteria entered above to be included in the summary.

	4B.14
	Max Age
	The maximum age of a stand that will be included in the summary.

	4B.15
	Min/Max Date
	The minimum and/or maximum survey dates to include in the summary.

	4B.16
	Single/Multiple Setting IDs
	Select this radio button if you want to select SOME of the settings that match the criteria entered above to be included in the summary.
A list of all setting IDs matching the criteria will appear in the list on the left.  Highlight settings to be included in the summary and move them from the left-hand list to the right-hand list using the arrows.  All setting IDs listed in the right-hand list will be included in the summary.

	4B.17
	Number of Settings
	The total number of settings in the list.

	4B.18
	Priorities
	Select the Priorities tab at the top of the screen and continue to Step 5.


[bookmark: _Step_5:_Define][bookmark: _Toc393983649]Step 5: Define the Data Priorities to Use in the Summary
If multiple data sets exist for a setting, this screen sets the priorities on which data set to use first, second, third, and so on.  If setting data does not exist in any of the priority options, the setting will not be included in the summary.
[bookmark: _Toc393983789]Figure 116: Data priority form
[image: ]
[bookmark: _Toc393724220]Table 16: Define data priorities steps
	Step
	Field
	Command

	5.1
	Priority
	Required.  Enter the priority number, in descending order, of the data to use for each setting in the summary.

	5.2
	Data Source
	Required.  Enter the data source for each priority.  “FSVeg” refers to the data stored in the FSVeg Oracle database tables and “PERM” refers to data migrated into the “perm” tables such as satellite and photo interpretation data.

	5.3
	Data Method
	Enter how the data was collected:
· Intensive: CSE intensive data
· Extensive: CSE extensive data
· Quick Plot: CSE quick plot data
· Stand Exam: Legacy summarized stand exam data (PERM source only)
· Photo Interpretation: Photo interpretations data (PERM source only)
· Satellite Image: Satellite imagery data
· No Tree Data Collected: Stand with down woody, cover, or surface cover data only

	5.4
	Cluster?
	If the data is cluster data, set the Data Source to “FSVeg” and set the Data Method to “Intensive.”

	5.5
	Groupings
	Select the “Groupings” tab at the top of the screen and continue to Step 6.


[bookmark: _Step_6:_Select/Create][bookmark: _Toc393983650]

Step 6: Select/Create One or More Groups to Use in the Summary
The data in each Summary can be “grouped” into logical categories.  Examples include:
· Tree Diameters: group the data by tree diameters
· Species: group the data by species
· Live/Dead: group the data by live and dead categories
· Wildlife: group the data by a variety of wildlife habitat categories
Each Summary may include one or more groups and each group may be used in one or more summaries, as shown in Figure 117.
[bookmark: _Ref410310882][bookmark: _Toc393983790]Figure 117: Summary/group diagram
[image: ]
Once a group is created for a summary, it can be used by any subsequent summaries.
If a group is used in a summary it cannot be changed, it must first be deleted from the summary or summaries that use it.  Then it can be changed and added back to the summary or summaries that use it.  When one of the summaries that use the group is re-run, the new group will be used to create the summary data.
When a group is deleted, the data created for that group is deleted from the summary dataset.
[bookmark: _Toc393983651]

Step 6A: Select an Existing Group
You may select an existing group(s) to use in your summary.
[bookmark: _Toc393983791]Figure 118: Select a group
[image: temp]
[bookmark: _Toc393724221]Table 17: Select an existing group steps
	Step
	Field
	Command

	6A.1
	Group Name
	Required.  Select the down arrow on the right end of the field to select a Group that has already been defined.  The group name and description are automatically populated.  This group and all its subgroups will be used in creating the Summary data when the summary is run.


[bookmark: _Toc393983652]Step 6B: Create a New Group
If none of the existing groups are what you want or need in your Summary, you may create a new group by clicking on the “Groupings Setup” button.
[bookmark: _Toc393983792]Figure 119: Group setup form
[image: ]
[bookmark: _Toc393724222]

Table 18: Create a new group steps
	Step
	Field
	Command

	6B.1
	Templates
	Select the template grouping.

	6B.2
	Group Name
	Required.  Scroll down to the bottom of this screen and enter a new, unique Group Name.

	6B.3
	Created By
	The system will enter the user name of the person who created the template.

	6B.4
	Description
	Required.  Enter a description of the new group being created.

	6B.5
	Save
	Save this new group by selecting File/Save or the yellow disc icon at the top of the screen.

	6B.6
	Tree Groupings
	Select the “Tree Subgroups” tab at the top of the page and continue to Step 7.


[bookmark: _Step_7:_Create][bookmark: _Toc393983653]Step 7: Create One or More Subgroups for Each Group
Each group contains one or more tree or cover “subgroups.”  A subgroup defines how the data will be combined and summarized.  For example, the “Tree Diameter” group may contain the following subgroups:
1. Oaks greater than 8 inches in diameter
2. All trees less than 5 inches in diameter
3. All trees between 5 and 7.9 inches in diameter
4. All trees between 8 and 15.9 inches in diameter
5. All trees between 16 and 24.9 inches in diameter
6. All trees 25 inches in diameter and greater
[bookmark: _Toc393983793]Figure 120: Tree subgroup setup screen
[image: ]
[bookmark: _Toc393724223]Table 19: Create subgroups steps
	Step
	Field
	Command

	7.1
	Subgroup Name
	Required.  Enter a subgroup name, up to 30 characters, for each subgroup.

	7.2
	Description
	Required.  Enter a description for each subgroup.

	7.3
	Formula
	Required.  This is an SQL statement, or a formula, which determines exactly how the trees will be combined in each subgroup.  In the example shown in Figure 121, the trees will be grouped into four subgroups:
· 5-8 inches in diameter
· 8-16 inches in diameter
· 16-25 inches in diameter
· 16+ inches in diameter

	7.4
	LOV
	The LOV button (down arrow) at the end of a blank formula line will bring up a list of previously defined formulas that can be copied and used or modified as needed, as shown in Figure 123.

	7.5
	All
	If you want to create your own formula from scratch, the box at the bottom of the screen contains all of the stand variables (such as age and diameter) that can be used in the formulas.

	7.6
	LOV
	This LOV button will query, by Region, Forest and District, for all the values of the “Column Name” variable currently stored in FSVeg.  For example if the user selected the first row and requested R09F05D21, the system would return all the stand ages stored in FSVeg for data for Region 9, Administrative Forest 5 and District 21.  If there is a LOT of data and/or if this query requires a lot of calculations this query may take a long time!!  The values that result from the query will eventually be displayed to the left of the form.
Another “add to Formula” button will appear.  If you highlight a value in the list, it will be selected at the end of the current formula record.


Step 7 can be repeated using any of the cover attributes.  To use cover attributes, select the “Cover Subgroups” instead of the “Tree Subgroups” tab in Step 6B.5 and continue with Step 7 using the cover attributes displayed.
[bookmark: _Toc393983794]Figure 121: Formula
[image: ]
[bookmark: _Toc393983795]Figure 122: Subgroups listing
[image: ]
[bookmark: _Toc393983796]Figure 123: Available subgroup formula columns
[image: ]
[bookmark: _Toc393983797]Figure 124: Add to formula
[image: ]
[bookmark: _Toc393983654]Step 8: Execute the Summary
Once the summary header record, settings, data priorities, groups, and subgroups have been defined, the summary can be executed.  The current session of FSVeg will remain active until the summary is completed.  This may take several hours.  You can minimize this session window and start another session to complete additional FSVeg work.
[bookmark: _Toc393724224]Table 20: Execute summary steps
	Step
	Field
	Command

	8.1
	(none)
	Return to the main summary screen.

	8.2
	Summarize?
	Change this field from “No” to “Yes” for the summary to be executed.

	8.3
	Run Summary
	Click on this button.  Any summary that has the “Summarize?” column set to “Yes” will be executed.

	8.4
	(none)
	When the summary has finished executing, the shaded fields to the right of the screen will be filled in with data about the execution.  Table 21 provides an explanation of these fields.


[bookmark: _Ref410311136][bookmark: _Toc393724225]Table 21: Execution fields
	Field
	Description

	Start Time
	Time the summary started executing.

	End Time
	Time the summary finished executing.

	Setting Count
	Number of settings included in the summary.

	Group Count
	Number of groups included in the summary.

	Subgroup Count
	Number of subgroups included in the summary.

	History
	Information about all of the past times this summary has been executed.

	Spatial/Non-Spatial
	Indicates if the summary used a spatial or non-spatial approach to include settings.

	Time (min)
	The number of minutes it took to execute the summary.

	Seconds/Setting
	The number of seconds it took to summarize each setting.  If this value exceeds 5 seconds, contact the FSVeg staff to determine how to speed up the execution time.

	Est. Run Time
	An estimate of how long it will take to execute the summary.

	Created By
	The person who created the summary.

	Modified By
	The person who last modified the summary.


[bookmark: _Step_9:_View][bookmark: _Toc393983655]Step 9: View the Summary Results
[bookmark: _Toc393983656]Step 9A: View the Summary Results – Characterizations
All of the summary results are stored in two FSVeg Oracle tables.  The results can be accessed in FSVeg via the summary forms or pulled into an Excel spreadsheet.
[bookmark: _Toc393724226]Table 22: Summary results steps
	Step
	Field
	Command

	9A.1
	(none)
	Return to the main summary screen.

	9A.2
	Summary Results
	Click on the “Summary Results” button at the bottom of the screen.

	9A.3
	Reg/For/Nat
	At the top of the screen, select “Forest,” “Region,” or “National” to display a list of summaries at the Forest, Region, or National level.

	9A.4
	Summary
	Highlight the summary that you are interested in.

	9A.5
	Spatial/Non-Spatial
	At the top of the screen, click on the “Spatial/Non-Spatial” tab to see information about the spatial or non-spatial method used to select settings which were included in the summary.

	9A.6
	Priorities
	At the top of the form, click on the “Priorities” tab to see information about the data priorities used to select data for each setting.

	9A.7
	Groupings
	At the top of the form, click on the “Groupings” tab to see information about the groups and subgroups used in the summary.

	9A.8
	Characterizations
	Summarized information about each setting in the summary.  The top portion of the screen contains the coverage name (if a spatial option was used), data source, data method, setting ID, and GIS link for each summary item.  Select one of the setting ID records to view the summary data in the bottom portion of the screen.  This data is stored in NRV_Characterization.


[bookmark: _Toc393983798]Figure 125: Example of spatial preferences
[image: ]
[bookmark: _Toc393983799]Figure 126: Example of non-spatial preferences
[image: ]
[bookmark: _Toc393983657]Step 9B: View the Summary Results – Summary Report
[bookmark: _Toc393724227]Table 23: View summary results steps
	Step
	Field
	Command

	9B.1
	File/Preferences
	From the top menu bar, select “File” then “Preferences” and select one or more settings to include in the report.  Then select “Close” to return to the results menu.

	9B.2
	Run Report from Preferences
	Select this button to create the report.

	9B.3
	Display Calculations?
	To display how each of the summary values was calculated, select “Yes.”  The example in Figure 127 is from a portion of the report.


[bookmark: _Ref410311235][bookmark: _Toc393983800][bookmark: _Ref410311228]Figure 127: View polygon characterization results
[image: ]
[bookmark: _Toc393983801]Figure 128: Summary results
[bookmark: _GoBack][image: ]
[bookmark: _Toc393983802]Figure 129: Setting characterization results with calculations
[image: ]
[bookmark: _Toc393983658]Step 9C: View the Summary Results – Groups
The “Group By” tab contains summary information for each setting ID, organized by group and subgroup.  In Figure 130 below, the setting has an average basal area of 126.6667 square feet for trees with a diameter between 5 and 10.9 inches DBH.
[bookmark: _Ref410311408][bookmark: _Toc393983803]Figure 130: View group by results
[image: ]
To access the permanent summary data stored in FSVeg, such as migrated legacy summaries or aerial photos summaries, select “Permanent Data” from the main Summary screen.
Figure 131: Permanent characterization data form
[image: ]
Access the data stored in the summary tables, (NRV_Characterizations, and NRV_Group_By) via either MS-Access or MS-Excel. Refer to the previous sections in this chapter for directions on using MS-Access and MS-Excel.


[bookmark: _Accessing_FSVeg_Data][bookmark: _Toc393983659]Accessing FSVeg Data Via Microsoft Excel
There are three steps involved in accessing FSVeg data through Microsoft Excel:
· Step 1: Download and install Add-in tool
· Step 2: Connect to I-Web
· Step 3: Created a customized query
Due to a documented bug in Microsoft Excel (see the Microsoft knowledge base article for additional information) that now affects NRM applications, the following workaround has been developed to enable extracting data into an Excel spreadsheet directly from FSVeg or FSVeg Spatial:
[bookmark: _Toc393983804]Figure 132: Add-Ins/I-Web/Create ODBC Connection
[image: ]
[bookmark: _Toc393983805]Figure 133: Production
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTMLf381ff.PNG]
[bookmark: _Toc393983806]Figure 134: eAuth
[image: ]
In the window shown in Figure 135, pick anything for a Read-Only user; it affects neither FSVeg nor FSVeg Spatial.
[bookmark: _Ref410311670][bookmark: _Toc393983807]Figure 135: Select a read-only user
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTMLf51826.PNG]
You will then get the message shown in Figure 136, when it appears acknowledge it by clicking on the OK button.
[bookmark: _Ref410311722][bookmark: _Toc393983808]Figure 136: Select a read-only user
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTMLf6e3ed.PNG]
[bookmark: _Toc393983809]Figure 137: Data > From Other Sources > From Microsoft Query
[image: ]
Next, uncheck Use the Query Wizard to create/edit queries and click on IWebEAuth*, then select OK, as shown in Figure 138.
[bookmark: _Ref410311787][bookmark: _Toc393983810]Figure 138: Choose Data Source window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTMLfeb4f1.PNG]
The Microsoft Query window, as shown in Figure 138, will begin to open and there will be a long delay (up to two minutes) before you can go further.  Eventually, the Add Tables window appears.  In the Owner box, enter an “F” (a quick way to get to the owners that start with “F”), then scroll down to FS_NRIS_FSVEG if using FSVeg (if using FSVeg Spatial, select the appropriate schema, such as S_R02_BKF), then select Add.  (Note: It doesn’t matter what table is selected at this point, in this example the selected table is nrv_aerial_photos.)
[bookmark: _Toc393983811]Figure 139: Microsoft Query, Query from IWebEAuth, Add Tables window
[image: ]
Then choose the Add Tables window.
In the Microsoft Query window, select File / New, as shown in Figure 140.
[bookmark: _Ref410315522][bookmark: _Toc393983812]Figure 140: Microsoft Query window
[image: ]
Check the Use the Query Wizard to create/edit queries box, then highlight IWebEAuth* and then click OK, as shown in Figure 141.
[bookmark: _Ref410315578][bookmark: _Toc393983813]Figure 141: Choose Data Source window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML10f067b.PNG]
Then click on the Options button, as shown in Figure 142.
[bookmark: _Ref410315630][bookmark: _Toc393983814]Figure 142: Query Qizard - Choose Columns window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML110bfea.PNG]
For FSVeg, make sure that the Owner is still FS_NRIS_FSVEG, and that both Tables and Views are checked, as shown in Figure 143.
[bookmark: _Ref410315683][bookmark: _Toc393983815]Figure 143: Table Options window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML116a633.PNG]
Alternatively, for FSVeg Spatial, you’ll want to select the appropriate schema, such as S_R02_BKF, and ensure that only Views are checked, as shown in Figure 144.
[bookmark: _Ref410315945][bookmark: _Toc393983816]Figure 144: Table Options window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML1196de4.PNG]
From this point forward, you can choose tables and columns of interest, specify selection criteria, specify the sort order, and extract the data to a spreadsheet in the same manner as existed prior to the emergency of the Microsoft Excel bug.
In the following example, stand and tree data are selected from the view nrv_stand_plot_tree_vm, as shown in Figure 145.
[bookmark: _Ref410316024][bookmark: _Toc393983817]Figure 145: Query Wizard - Choose Columns window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML136282e.PNG]
[bookmark: _Toc393983818]Figure 146: Query Qizard - Filter Data window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML1373a09.PNG]
[bookmark: _Toc393983819]Figure 147: Query Wizard - Sort Order window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML137c650.PNG]
[bookmark: _Toc393983820]Figure 148: Query Wizard - Finish window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML1381376.PNG]
[bookmark: _Toc393983821]Figure 149: Import Data window
[image: C:\Users\rmita\AppData\Local\Temp\1\SNAGHTML138719c.PNG]
The data are returned to a spreadsheet, as shown in Figure 150.
[bookmark: _Ref410384368][bookmark: _Toc393983822]Figure 150: Query data returned in Excel spreadsheet
[image: ]
You will notice that the original Microsoft Query window disappears.
[bookmark: _Toc393983660]Step 1: Download and Install the Add-In Tool
The I-Web Office Add-in of Access and Excel is a tool that plugs in to the Microsoft Access and Excel menu bars.  The tool must be downloaded and installed on your computer before you can use it.  The following process will install the Office Add-In tool in both Access and Excel simultaneously.  This step only needs to be done once per computer.  If this step has already been completed for your computer, skip to Step 2.
[bookmark: _Toc393724228]

Table 24: Download and install steps
	Step
	Directions

	1.1
	To install, be sure to right-click and select Run Elevated.

	1.2
	Log into the I-Web Main Menu.  Select the default dashboard and enter your eAuth username and password.
Expand the TOOLS folder, click on the Remote Queries folder, and click on the Access and Excel Add-In, as shown in Figure 151.

	1.3
	Scroll to the bottom of the page and click on the Download button, as shown in Figure 152.
A standard File Download box will be displayed.

	1.4
	Click Run and the program will automatically install.
Close the I-Web Access and Excel Add-In window when done.


[bookmark: _Ref410382097][bookmark: _Toc393983823]Figure 151: I-Web Main Menu screen
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[bookmark: _Ref410382107][bookmark: _Toc393983824]Figure 152: Download button
[image: ]
[bookmark: _Step_2:_Connect][bookmark: _Toc393983661]Step 2: Connect to I-Web
[bookmark: _Toc393724229]Table 25: Connect to I-Web steps
	Step
	Directions

	2.1
	From the PC desktop, launch Microsoft Excel from an icon or Start>Programs>Microsoft Excel

	2.2
	From the I-Web menu, select the “Add-Ins” tab, then you will see the I-Web on the toolbar, as shown in Figure 153.

	2.3
	Click on I-Web and then on Create ODBC Connection, as shown in Figure 154.

	2.4
	Select “Production” to set it as your default environment, then click “OK,” as shown in Figure 155.

	2.5
	Provide your eAuth credentials.  You are then prompted to select a Read-Only user account, as shown in Figure 156.  It does not matter what account you select, FSVeg does NOT filter based on these accounts.  Select “All Units” and click the “OK” button.
An intermediate window will appear telling you the connection is set up as an FS_Public account.  Click “OK.”


[bookmark: _Ref410371186][bookmark: _Toc393983825]Figure 153: I-Web showing in the toolbar
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[bookmark: _Ref410371205][bookmark: _Toc393983826]Figure 154: Create ODBC Connection link
[image: ]
[bookmark: _Ref410371226][bookmark: _Toc393983827]Figure 155: Set Production environment
[image: ]
[bookmark: _Ref410371239][bookmark: _Toc393983828]Figure 156: Select a Read-Only User
[image: ]
[bookmark: _Toc393983662]Find the I-Web Connection
If you cannot find the I-Web connection on your Excel Add-In tab:
1. In Excel, click Alt-F
2. Click “Excel Options” then click “Add-Ins” on the left of the Excel Options window
3. Select “Disabled Items” from the list next to “Manage” near the bottom of the window, and click “Go”
4. If “mscoree.dll” is in the list, select it then click the “Enable” button
5. Close the dialogs, exit Excel and launch it again
If this does not enable the Excel Add-In, the best alternative may be to run Excel from Citrix:
1. Open Internet Explorer and go to the Citrix login page by entering https://apps.fs.fed.us/Citrix/auth/login.aspx (you may want to add this to your Favorites)
2. Log in with your Active Directory username and password
3. Navigate to “\Office Automation\MS Office” in the Applications window and open Excel
[bookmark: _Step_3:_Create][bookmark: _Toc393983663]Step 3: Create a Customized Query
[bookmark: _Toc393724230]Table 26: Create customized query steps
	Step
	Directions

	3.1
	From the Excel main menu, select “Data,” “From Other Sources,” and then “From Microsoft Query,” as shown in Figure 157.

	3.2
	From the “Choose Data Source” window and the “Databases” tab, select “IWebEAuth*,” and then select “OK,” as shown in Figure 158.

	3.3
	After a few seconds, a window titled “Choose Columns” should appear.  Select the “Options” button, as shown in Figure 159.  Under the “Show” section, toggle the types of items you need (“Views” was selected here, since the view nrv_cse_all_vm is used later in the example).  In the “Owner” section, scroll down to and select “FS_NRIS_FSVEG”.  These actions will greatly reduce the list that will appear in “Available tables and columns” by eliminating apparent duplicates as well as displaying only items in the FSVeg database.  Select “OK” to confirm your choices and return to the Query Wizard – Choose Columns window.

	3.4
	Scroll down to the “NRV_CSE_ALL_VM” view or the table/view of your choice, as shown in Figure 160.  If there is more than one listing, the views will be listed first, then the synonyms and then the tables of the same name.  Select the first name if multiple names appear.  Click the “+” box next to the table or view to see all the column in the table or view, then select “Next.”

	3.5
	To select all of the columns in a table or view, highlight the table or view name, click the “>” symbol to move them to the box on the right.  However, it is suggested that only select specific columns are selected.  Selecting a large amount of data may slow the query down.

	3.6
	To select individual columns in a table or view, highlight the column names, one at a time, then click the > symbol, as shown in Figure 161.  The column name will be displayed in the box on the right.  Be sure to select Region (Proc or Admin), Forest (Proc or Admin) and District.
To unselect a column, highlight it in the box on the right, and click the < symbol.  To unselect all columns, click the << symbol.

	3.7
	The “Preview Now” button will display all the data in a column in the box above the button.  WARNING: Do not select this button unless absolutely necessary!!!  You are essentially querying the whole database of 5 million plus records!  This will tie up the system and the query may eventually fail.

	3.8
	Once all the columns you want displayed are selected, select “Next.”

	3.9
	For each column selected, the data can be filtered with logical expressions, as shown in Figure 162.  Each column selected can be filtered with up to three logical expressions.  Additional filtering can be done later.  Highlight a column.  To specify the filters, use the drop down arrows and/or type in the parameters.

	3.10
	Be sure to select the Region (Proc or Admin) column and set it EQUAL to your Region (i.e., 09).
Be sure to select the Forest (Proc or Admin) column and set it EQUAL to your Forest (i.e., 13).
Be sure to select the District column and set it equal to your District (i.e., 05).
When all filtering has been entered, select “Next.”

	3.11
	The data can be brought into Excel sorted, in ascending or descending order, on a maximum of three columns.  Once the data is in Excel, it can be sorted using Excel sort functions, as shown in Figure 163.  When all of the sort selections have been entered, select “Next.”

	3.12
	If you want to save a version of your query as is, select “Save Query,” as shown in Figure 164.  It is recommended that you View the data or edit the query before you place the data in an Excel spreadsheet.
Click “Finish.”


[bookmark: _Ref410378175][bookmark: _Toc393983829]Figure 157: Select a Read-Only User
[image: ]
[bookmark: _Ref410378202][bookmark: _Toc393983830]Figure 158: Choose data source
[image: ]
[bookmark: _Ref410378239][bookmark: _Toc393983831]Figure 159: Query Wizard
[image: ]
[bookmark: _Ref410378263][bookmark: _Toc393983832]Figure 160: Choose columns
[image: ]
[bookmark: _Ref410378285][bookmark: _Toc393983833]Figure 161: Choose columns
[image: ]
[bookmark: _Ref410378309][bookmark: _Toc393983834]Figure 162: Filter data
[image: ]
[bookmark: _Ref410378617][bookmark: _Toc393983835]Figure 163: Sort order
[image: ]
[bookmark: _Ref410378636][bookmark: _Toc393983836]Figure 164: Finish query wizard
[image: ]
[bookmark: _Toc393983664]Step 4: Using Microsoft Query
[bookmark: _Toc393724231]Table 27: Microsoft Query operations
	Operation
	Description

	Menu/Toolbar
	Most functionality can be accessed through either the menu bar or the tool bar, as shown in Figure 165.  As in most Microsoft applications, placing your mouse cursor on an icon on the tool bar will pop up a brief description of its function.  Selecting a menu item will bring up submenus.

	Object Display Section
	As columns are added to or deleted from the query, they are displayed or disappear from this area, as shown in Figure 166.  Stretching the frame around the object may be necessary to view the entire name of the columns.

	Filter Display Section
	Displays any selection criteria applied to the query, as shown in Figure 167.  This section may not exist if no criteria were added.

	Data Display Section
	All data that fits the selection criteria is displayed here, as shown in Figure 168.  Columns can be resized, inserted, deleted, or added.

	Record Section
	Contains the current record number, as shown in Figure 169.  Select the “>|” symbol to jump to the last record and obtain the total number of records returned by the query.

	Add a Column
	Either:
· Double click on the column name in the Object Display Section; the data will be added to the first blank column in the spreadsheet, or
· Go to the first blank column, select the column from the pull-down list, as shown in Figure 170.
If the added column name 

	Delete a Column
	Highlight the column and either:
· Select the “Delete” key on the keyboard, or
· Select Edit > Delete on the menu bar

	Hide/Show a Column
	Use “FORMAT” on the menu bar.

	Change the Filtering Criteria
	Select Criteria/Add Criteria and the “Add Criteria” dialog box will pop up, as shown in Figure 171.  Select Criteria/Remove all Criteria to delete all current criteria for a column.
· Choose the column, operator, and values from the pull-down lists.  The “Values” button will bring up a list of all values in the specified field.
· If the column is numeric, you can select to sum or average the data using the “Total” pull-down list.
· Once a new filter has been applied, the data should automatically refresh.  If it does not, select the “!” symbol in the tool bar to refresh the data.

	Sort
	On the menu bar, go to Records>Sort, as shown in Figure 152.  This will open the “Sort” dialog box.  Select columns from the pull-down list and select “Add.”  They will move to the bottom box with any columns already selected.  Choose an Ascending or Descending sort when you select the column before adding it to the list.
Highlighting a column name in the bottom box allows you to change the direction of the sort or remove that column from the sort selection.  Data sorting is applied in the order the columns are listed in the bottom box.  Select “Close” when finished.

	View SQL Code
	Select the “SQL” button in the toolbar to display the SQL query statement based on your selection criteria.  Edits to the SQL query statement are reflected in the data output display.

	Save the Query
	Once the Query is completed it can be saved and used again.  Go to File>Save and name the query accordingly.  If you do not specify a path name, Excel will default to C:\Documents and Settings\<user name>\Application Data\Microsoft\Queries.


[bookmark: _Ref410378875][bookmark: _Toc393983837]Figure 165: Select a Read-Only User
[image: ]
[bookmark: _Ref410378895][bookmark: _Toc393983838]Figure 166: Query from CSE_data
[image: ]
[bookmark: _Ref410378977][bookmark: _Toc393983839]Figure 167: Criteria field
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[bookmark: _Ref410379022][bookmark: _Toc393983840]Figure 168: Setting list
[image: ]
[bookmark: _Ref410379074][bookmark: _Toc393983841]Figure 169: Record number field
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[bookmark: _Ref410379133][bookmark: _Toc393983842]Figure 170: Exam purpose codes
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[bookmark: _Ref410379177][bookmark: _Toc393983843]Figure 171: Add criteria
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[bookmark: _Toc393983844]Figure 172: Sort
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[bookmark: _Step_5:_Place][bookmark: _Toc393983665]Step 5: Place the Results into an Excel Worksheet
[bookmark: _Toc393724232]Table 28: Place results in worksheet steps
	Step
	Directions

	5.1
	Select File>Return Data to Microsoft Excel, as shown in Figure 173.
This will open a new Microsoft Excel spreadsheet.  By default the first cell is selected.

	5.2
	You are then asked where to place the data, see Figure 174 below.
Unless you are appending the data to an existing worksheet, take the default.  You may choose a different starting place on the worksheet to place the data.
Selecting a new worksheet prevents the data from overwriting existing data if the query has been run more than once.
Select “OK” to finish.

	5.3
	Any changes made to the column headings, column width, deleted columns, etc., revert to those returned by the query.


[bookmark: _Ref410379315][bookmark: _Toc393983845]Figure 173: Return data to Microsoft Excel
[image: ]
[bookmark: _Ref410379330][bookmark: _Toc393983846]Figure 174: Return external data to Microsoft Excel
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[bookmark: _Toc393983666]Step 6: Editing Existing Queries
Any saved queries can be re-used as is or edited to create a new query.
[bookmark: _Toc393724233]Table 29: Editing existing queries steps
	Step
	Directions

	6.1
	From a blank Excel spreadsheet, go to Data > Get External Data > Run Saved Query, as shown in Figure 175.

	6.2
	This will bring up the “Run Query” dialog box, as shown in Figure 176.  Select the query, then “Get Data” to bring the data into a new spreadsheet.

	6.3
	Specify where to put the data, as shown in Figure 177.

	6.4
	You will be prompted to connect to the database via eAuth.  Upon connection the query will be run and the data will be placed in the spreadsheet.

	6.5
	Once the query is run, it may be edited by going into Data > Get External Data > Edit Query.


[bookmark: _Ref410379461][bookmark: _Toc393983847]Figure 175: Get external data
[image: ]
[bookmark: _Ref410379477][bookmark: _Toc393983848]Figure 176: Run query
[image: ]
[bookmark: _Ref410379497][bookmark: _Toc393983849]Figure 177: Returning external data to Excel
[image: ]
[bookmark: _Toc393983667]Step 7: Perform Calculations
You may create your own data from existing data stored in the spreadsheet.
[bookmark: _Toc393724234]Table 30: Perform calculations steps
	Step
	Directions

	7.1
	Select the cell you want to contain a formula or calculated data.  You may want to insert a new column or row to contain the calculated data.

	7.2
	Press the equal sign (=) to activate the Formula Bar.

	7.3
	Type the formula, without spaces, and then press Enter when done.

	7.4
	Examples:
· =A1/2+100 (Divide the value in cell A1 by 2, then add 100)
· =A1+4*5 (Multiply 4x5, then add to the value in cell A1)
· =(A1-2)*4 (Subtract 2 from the value in cell A1, then multiply by 4)

	7.5
	To copy a formula across a range of cells:
· Select the cell containing the formula then drag the fill handle over the adjacent cells.


[bookmark: _Toc393983668]Step 8: Create Charts and Graphs
You may create charts and graphs from data stored in the spreadsheet.
[bookmark: _Toc393724235]Table 31: Create charts and graphs steps
	Step
	Directions

	8.1
	Select the cells you wish to include in the chart or graph by clicking and dragging.

	8.2
	To create a chart, select the column chart, line chart, or pie chart icon.

	8.3
	To cut a pie chart into slices, click on a pie slice until a handle appears around its edges then drag the slice away from the pie.




[bookmark: _Toc393983669]Using Excel to Create a List of Stands for FSVeg Reports
Step 1. If you have not already done so, refer to the Accessing FSVeg Data via Microsoft Excel section of this document and install the I-Web Add-In for Microsoft Excel.
Step 2. Follow Step 2 in the Accessing FSVeg Data via Microsoft Excel section to connect to I-Web.
Step 3. Follow Step 3.1 through Step 3.3 in the Accessing FSVeg Data via Microsoft Excel section to create a customized query.  In Step 3.3, connect to NRM_STAND_VM if you only want to query stand level attributes.  Connect to NRV_CSE_ALL_VM if you will be querying plot or tree level attributes.  You can then skip Step 3.4
Step 4. In Step 3.5, ALWAYS select the following:
· PROJECT_NAME
· REGION_PROC
· FOREST_PROC
· DISTRICT
· LOCATION
· STAND
· SETTING_ID
Step 5. Skip Step 3.6, perform Step 3.7.
Step 6. In Step 3.8, ALWAYS set the following filters:
Table 32: Set Filters
	Required Fields
	Filter
	Code
	Description

	REGION_PROC
	equals
	06
	2-digit Region value

	FOREST_PROC
	equals
	03
	2-digit Forest value

	DISTRIC
	equals
	34
	2-digit District value

	LOCATION
	equals
	00765
	Location value, if you know it

	PROJECT_NAME
	equals
	XYZ
	Project, ,if you know it




Step 7. Now comes the part where you get to Customize the query for the stands you are looking for.  There is no limit to what you can look for.  The following six examples are only interested in STAND level attributes, so in Step 3.3, connect to NRV_STAND_VM.
Example 1: Stands containing Loblolly pine which are 40-60 years old
	In Step 3.5, select the following:
· EV
· EV_REF
· AGE
	In Step 3.8, select the following filters:
Table 33: Set Filters
	Field
	Filter
	Code

	EV
	equals
	13

	EV
	or equals
	31

	EV
	or equals
	29

	EV
	or equals
	28

	EV_REF
	equals
	FSHR8

	AGE
	greater than
	39

	AGE
	less than
	61


Example 2: Stands above 3000 feet in elevation
	In Step 3.5, select the following:
· ELEVATION
	In Step 3.8, select the following:
· ELEVATION greater than 2999
Example 3: Stands between 10% and 20% slope
	In Step 3.5, select the following:
· SLOPE
	In Step 3.8, select the following:
· SLOPE greater than 09 and less than 21
Example 4: Stands established before 1950
	In Step 3.5, select the following:
· ORIGIN_YEAR
	In Step 3.8, select the following:
· ORIGIN_YEAR less than 1951
Example 5: Stands with an existing vegetation longleaf, loblolly, ro shortleaf pine
	In Step 3.5, select the following:
· EV
· EV_REF
	In Step 3.8, select the following:
· EV_REF equals FSHR8
· EV equals 21, or
· EV equals 31, or
· EV equals 32
Example 6: Stands containing loblolly pine trees, and above a certain stocking
	In Step 3.5, select the following:
· EV
· MERCH_CUBIC_STOCKING
	In Step 3.8, select the following:
· EV equals XX (2-digit code for Loblolly pine stands)
· MERCH_CUBIC_STOCKING greater than XXX (your minimum value)
Step 8. The following examples are interested in tree level attributes, so in Step 3.3, connect to the NRV_CSE_ALL_VM.
Example 1: Stands containing trees of Species A over X inches in diameter and Y feet in height
	In Step 3.5, select the following:
· TREE_SPECIES
· TREE_DIAMETER
· TREE_HEIGHT
	In Step 3.8, select the following:
· TREE_SPECIES equals XXXX (NRCS species code)
· TREE_DIAMETER greater than XXXX (your minimum value)
· TREE_HEIGHT greater than XXXX (your minimum value)
Example 2: Stands containing any Port Orford species
	In Step 3.5, select the following:
· TREE_SPECIES
	In Step 3.8, select the following:
· TREE_SPECIES equals CHLA
Example 3: Stand containing dead trees over X inches in diameter and Y feet in height and decay class of 3 or more
	In Step 3.5, select the following:
· TREE_LOG_SNAG_DECAY
· TREE_DIAMETER
· TREE_HEIGHT
	In Step 3.8, select the following:
· TREE_LOG_SNAG_DECAY greater than 2
· TREE_DIAMETER greater than XXXX (your minimum value)
· TREE_HEIGHT greater than XXXX (your minimum value)
Example 4: Stands containing trees with dwarf mistletoe ratings above a value of 2
	In Step 3.5, select the following:
· TREE_DAMAGE_AGENT1
· TREE_DAMAGE_AGENT2
· TREE_DAMAGE_AGENT3
· TREE_DAMAGE_AGENT4
· TREE_DAMAGE_AGENT5
· TREE_DAMAGE_CATEGORY1
· TREE_DAMAGE_CATEGORY2
· TREE_DAMAGE_CATEGORY3
· TREE_DAMAGE_CATEGORY4
· TREE_DAMAGE_CATEGORY5
· TREE_DAMAGE_SEV1
· TREE_DAMAGE_SEV2
· TREE_DAMAGE_SEV3
· TREE_DAMAGE_SEV4
· TREE_DAMAGE_SEV5
	In Step 3.8, select the following:
· TREE_DAMAGE_AGENT1 equals 23
· TREE_DAMAGE_AGENT2 equals 23
· TREE_DAMAGE_AGENT3 equals 23
· TREE_DAMAGE_AGENT4 equals 23
· TREE_DAMAGE_AGENT5 equals 23
· TREE_DAMAGE_CATEGORY1 equals 001
· TREE_DAMAGE_CATEGORY2 equals 001
· TREE_DAMAGE_CATEGORY3 equals 001
· TREE_DAMAGE_CATEGORY4 equals 001
· TREE_DAMAGE_CATEGORY5 equals 001
· TREE_DAMAGE_SEV1 greater than 2
· TREE_DAMAGE_SEV2 greater than 2
· TREE_DAMAGE_SEV3 greater than 2
· TREE_DAMAGE_SEV4 greater than 2
· TREE_DAMAGE_SEV5 greater than 2
Step 9. These queries can be saved to be run at a later time and can be easily modified.
Step 10. Once you have the list of stands that meet your criteria, you can go into FSVeg and use the list building function to create a list of stands and use that list with any of the reports.


[bookmark: _Toc393983670]Accessing FSVeg Data Via Microsoft Access
[bookmark: _Step_1:_Download][bookmark: _Toc393983671]Step 1: Download and Install the Add-In Tool
The I-Web Office Add-in of Access and Excel is a tool that plugs in to the Microsoft Access and Excel menu bars.  The tool must be downloaded and installed on your computer before you can use it.  The following process will install the Office Add-in tool in both Access and Excel simultaneously.  This step only needs to be done once per computer.  If this step has already been completed for your computer, skip to Step 2.
[bookmark: _Toc393724236]Table 34: Download and install Add-In steps
	Step
	Directions

	1.1
	To install, be sure to right-click and select Run Elevated.

	1.2
	Log into the I-Web Main Menu.  Select the default dashboard and enter your eAuth username and password.
Expand the Tools folder, click on the Remote Queries folder, and click on the Access & Excel Add-In, as shown in Figure 178.

	1.3
	Scroll to the bottom of the page and click on the “Download” button, as shown in Figure 179.
A standard File Download box will be displayed.

	1.4
	Click “Run” and the program will automatically install.
Close the I-Web Access and Excel Add-In window when done.


[bookmark: _Ref410385215][bookmark: _Toc393983850]Figure 178: I-Web main menu
[image: ]
[bookmark: _Ref410385233][bookmark: _Toc393983851]Figure 179: Download button
[image: ]
[bookmark: _Step_2:_Connect_1][bookmark: _Toc393983672]Step 2: Connect to I-Web
[bookmark: _Toc393724237]Table 35: Connect to I-Web steps
	Step
	Directions

	2.1
	From the PC desktop, launch Microsoft Access from an icon or the Start menu.  Open up a new or pre-existing Access database, as shown in Figure 180.

	2.2
	Click the “Add-Ins” tab and you will see “I-Web” on the toolbar, as shown in Figure 181.

	2.3
	Select “Production,” set as your default environment, and click “OK,” as shown in Figure 182.

	2.4
	Provide your eAuth credentials.  You are then prompted to select a Read-Only user account, as shown in Figure 183.  It does not matter what account you select, FSVeg does NOT filter based on these accounts.  Select “All Units” and click the “OK” button.
An intermediate window will appear telling you the connection is set up as an FS_Public account.  Click “OK.”


[bookmark: _Ref410385285][bookmark: _Toc393983852]Figure 180: Access File menu
[image: ]
[bookmark: _Ref410385294][bookmark: _Toc393983853]Figure 181: Access Add-Ins tab
[image: ]
[bookmark: _Ref410385302][bookmark: _Toc393983854]Figure 182: Select I-Web server
[image: ]
[bookmark: _Ref410385313][bookmark: _Toc393983855]Figure 183: Select a read-only user
[image: ]
[bookmark: _Step_3:_Create_2][bookmark: _Toc393983673]Step 3: Create a Customized Query
[bookmark: _Toc393724238]Table 36: Editing existing queries steps
	Step
	Directions

	3.1
	From the MS-Access main menu, select “ODBC Database,” as shown in Figure 184.

	3.2
	Select the “Import the source data into a new table in the current database” option and click on the “OK” button.

	3.3
	Click on the “Machine Data Source” tab, as shown in Figure 185.  Highlight “IWebEarth” and then click on “OK.”

	3.4
	After a few seconds, a window titled “Link Tables” should appear.  Scroll down and highlight the “FS_NRIS_FSVEG.NRV_CSE_ALL_VM” view, as shown in Figure 186, or the table/view of your choice.  Then click the “OK” button.

	3.5
	Select up to 10 fields to uniquely identify each report.  It is suggested that you select the Setting ID and the Measurement Date, as shown in Figure 187.  Then select “OK.”

	3.6
	The table is now linked to your Access database, as shown in Figure 188.

	3.7
	Select Insert > Query, as shown in Figure 189.

	3.8
	Make certain that Design View is highlighted in the New Query window that appears, then select “OK,” as shown in Figure 190.

	3.9
	Use the query window shown in Figure 191 to narrow down the records to be retrieved.

	3.10
	All the columns in the view or table are available and listed in the upper window.
By double-clicking on each column, it will appear in the query portion in the lower window.  To specify what values to retrieve, enter criteria in the application columns.
The process fails if it attempts to retrieve too many records.  To include columns that can limit the retrieval to only those records needed for analysis, an example of which is shown in Figure 192.  To do this:
1. Include either:
a. PROC_REGION and PROC_FOREST
b. ADMIN_REGION and ADMIN_FOREST
2. Specify values for them such as PROC_REGION = “09”
3. Include other columns, such as DISTRICT, PROJECT_NAME, and LOCATION to retrieve only the records needed
Include data columns needed for the analysis.  If the query was saved, it can be edited and re-run to pick up the needed data.

	3.11
	Select “Run” from the query toolbar or Query > Run from the main menu bar, as shown in Figure 193.

	3.12
	Results appear in a spreadsheet-like window, such as that shown in Figure 194.


[bookmark: _Ref410385454][bookmark: _Toc393983856]Figure 184: ODBC Database choice in Access External Data menu
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[bookmark: _Ref410385470][bookmark: _Toc393983857]Figure 185: Select Data Source window
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[bookmark: _Ref410385477][bookmark: _Toc393983858]Figure 186: Link Tables window
[image: ]
[bookmark: _Ref410385484][bookmark: _Toc393983859]Figure 187: Select Unique Record Identifier window
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[bookmark: _Ref410385491][bookmark: _Toc393983860]Figure 188: db3: Database (Access 2000 file format) window
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[bookmark: _Ref410385499][bookmark: _Toc393983861]Figure 189: Microsoft Access window, Insert > Query highlighted
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[bookmark: _Ref410385507][bookmark: _Toc393983862]Figure 190: New Query window
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[bookmark: _Ref410385528][bookmark: _Toc393983863]Figure 191: Query 1: Select Query window
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[bookmark: _Ref410385552][bookmark: _Toc393983864]Figure 192: Select Query window filled in
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[bookmark: _Ref410385595][bookmark: _Toc393983865]Figure 193: Microsoft Access window
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[bookmark: _Ref410385610][bookmark: _Toc393983866]Figure 194: Query 1: Select Query data records window
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